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Abstract 

 

 

Key features 
• As a structural analogue of aminoacyl-transfer RNA, puromycin incorporates into the elongating peptide chain. 

• Detection of puromycin-labeled peptides by western blotting reflects translation rates without the need for 

radioactive isotopes. 

• The protocol described here for in vitro applications is derived from the SUnSET method originally published by 

Schmidt et al. (2009). 
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This protocol is used in: Mol. Oncol. (2023), DOI: 10.1002/1878-0261.1349 

 

 

As the most energy- and metabolite-consuming process, protein synthesis is under the control of several intrinsic 

and extrinsic factors that determine its fine-tuning to the cellular microenvironment. Consequently, variations in 

protein synthesis rates occur under various physiological and pathological conditions, enabling an adaptive response 

by the cell. For example, global protein synthesis increases upon mitogenic factors to support biomass generation 

and cell proliferation, while exposure to low concentrations of oxygen or nutrients require translational repression 

and reprogramming to avoid energy depletion and cell death. To assess fluctuations in protein synthesis rates, 

radioactive isotopes or radiolabeled amino acids are often used. Although highly sensitive, these techniques involve 

the use of potentially toxic radioactive compounds and require specific materials and processes for the use and 

disposal of these molecules. The development of alternative, non-radioactive methods that can be easily and safely 

implemented in laboratories has therefore been encouraged to avoid handling radioactivity. In this context, the 

SUrface SEnsing of Translation (SUnSET) method, based on the classical western blot technique, was developed by 

Schmidt et al. in 2009. The SUnSET is nowadays recognized as a simple alternative to radioactive methods assessing 

protein synthesis rates. 
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Background 
 

As a structural analogue of aminoacyl-tRNA, the aminonucleoside antibiotic puromycin is incorporated through 

non-hydrolysable peptide bounding into the growing peptide chain along the elongation process (Nathans, 1964). 

While high concentrations block the elongation phase and hence translation, at low doses the overall translation rate 

of protein synthesis remains unchanged. Consequently, the rate of formation of puromycin-labeled peptides mirrors 

the rate of protein translation. Taking advantage of this property, 3H-puromycin labeling was first used in 1979 to 

assess the rate of protein synthesis in various tissues in vivo under nutrient- and protein-poor diets (Nakano and 

Hara, 1979). The SUnSET (SUrface SEnsing of Translation) technique was developed 30 years later by Schmidt 

and colleagues to detect variations in protein synthesis rates in cultured cells by western blotting (Schmidt et al., 

2009). This method was then coupled with other techniques (fluorescence-activated cell sorting or 

immunohistochemistry) to assess protein synthesis at different scales. Further developments, notably based on the 

Clik-it technology combined with O-propargyl puromycin (OP-Puro), a puromycin analogue, enable visualization 

of puromycilated proteins and assessment of elongation rates in tissues (Morral et al., 2020). The main advantage 

of using puromycin and its analogues is that it does not require radioactive isotopes such as 35S-methionine, 

historically used to measure protein synthesis rates, with comparable analytical performance (Schmidt et al., 2009). 

Because proteostasis defects are associated with a variety of chronic diseases (cancer, tissue fibrosis, inflammatory 

syndromes, etc.) or aging, it is necessary to monitor the changes in protein synthesis rates in response to a variety 

of stressors in order to better understand the translational reprogramming underlying cell adaptation. The following 

protocol describes a SUnSET method (Figure 1) suitable for assessing protein synthesis rates in lysates from cells 

grown in vitro by conventional western blot analysis. 

 

 
 

Figure 1. Principle of the SUnSET assay. During the elongation step, addition of puromycin leads to its 

incorporation into the A site of the ribosome. The transfer and linkage of the polypeptide to the puromycin cause 

the termination of translation releasing puromycilated proteins that can subsequently be detected by western blotting 

against the puromycin. 
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Materials and reagents 
 

Biological materials 

 

Cell lines of interest obtained from the American Type Culture Collection (ATCC). In this study, we used the colon 

cancer cell line HCT116. 

 

Reagents 

 

1. Puromycin (Sigma-Aldrich, catalog number: P9620)  

2. PBS (Sigma-Aldrich, catalog number: D1408) 

3. Complete anti-protease (Roche, catalog number: 11836145001) 

4. Dry milk (Régilait, catalog number: 304934416704) 

5. Bovine serum albumin (BSA) (Roche, catalog number: 10735094001) 

6. DC Protein Assay kit (Bio-Rad, catalog number: 5000111) 

7. Prestained protein ladder (Euromedex, catalog number: 06P-0111) 

8. Immobilion Forte western substrate (Merck Millipore, catalog number: WBLUF0500) 

9. Ponceau red solution (Sigma-Aldrich, catalog number: 141194)  

10. Mouse anti-puromycin antibody (clone 12D10) (Merck Millipore, catalog number: MABE343) 

11. Mouse anti-tubulin antibody (clone DM1A) (Sigma, catalog number: T6199) 

12. HRP-conjugated anti-mouse secondary antibody (Cell Signaling Technology, catalog number: 7076) 

13. Stripping buffer (Thermo Scientific, catalog number: 21059) 

 

Solutions 

 

1. RIPA protein lysis buffer 2× (see Recipes) 

2. Tris-buffered saline-Tween (TBS-T) (see Recipes) 

a. TBS-T 5% BSA (see Recipes)  

b. TBS-T 5% dry milk (see Recipes) 

3. Laemmli 6× (see Recipes) 

 

Recipes 

 

1. RIPA protein lysis buffer 2× 

Reagent Final concentration 

Tris-HCl pH 7.2 100 mM 

NaCl 300 mM 

EDTA 10 mM 

Sodium deoxycholate 2% 

SDS 20% 0.1% 

Triton 100× 2× 

Na3VO4 4 mM 

β glycerophosphate 20 mM 

NaF 20 mM 

Complete anti-protease 2× 

Dilute to 1× in H2O. 

 

2. Tris-buffered saline-Tween (TBS-T) 

Reagent Final concentration 

Tris-HCl pH 7.5 50 mM 
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NaCl 

Tween 

150 mM 

0.1% 

Add 5% of BSA or dry milk for obtaining TBS-T 5% BSA or 5% dry milk, respectively. 

 

3. Laemmli 6× 

Reagent Final concentration 

Tris-HCl pH 6.8 0.5 M 

Glycerol 1% 

SDS 20% 2% 

DTT 0.6 M 

Bromophenol blue 0.4% 

 

Laboratory supplies 

 

1. 6-well or 10 cm diameter tissue culture plates 

2. Sterile scrapers 

3. Microcentrifuge tubes 

4. Plastic wrap 

 

 

Equipment 
 

1. Tissue culture apparatus (tissue culture hood, CO2 incubator, etc.) 

2. Pipettes and micropipettes 

3. Vacuum pump 

4. Centrifuge (4 °C) 

5. Cold room 

6. Heat block 

7. Western blotting apparatus (SDS-PAGE running cassette, power supply, shaker, transfer cassette, nitrocellulose 

membrane, etc.) 

8. ChemiDoc imaging system (Bio-Rad, catalog number: 12003153) 

 

 

Software and datasets 
 

1. Fiji (National Institutes of Health) 

 

 

Procedure 
 

A. Puromycin incorporation in vitro 

 

1. Seed HTC116 cells one day before the experiment and maintain at 37 °C and 5% CO2 to allow attachment 

to the tissue culture plate. In the experiment presented in Figure 2, 200,000 cells per well were seeded in 

a 6-well plate. 

2. On the day of the experiment, apply the studied treatment on cells for the desired time. 

3. Before harvesting and 15 min before the end of the treatment, expose cells to 5 μg/mL puromycin directly 

diluted in the media. All samples must be incubated with the same concentration of puromycin for an equal 

period.  
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B. Protein extracts 

 

1. At the end of the 15-min incubation with puromycin, remove media and rinse cells once with cold PBS.  

2. Put the tissue culture plate on ice and incubate with 1× RIPA protein lysis buffer (see Recipes) containing 

proteases and phosphatases inhibitors (1 volume of 1× RIPA for 1 volume of cell pellet) for 20 min.  

3. Scrape the cells and collect in a microcentrifuge tube.  

4. Centrifuge at 13,000× g for 20 min at 4 °C to get rid of cellular debris.  

5. Collect the supernatant in a new microcentrifuge tube and add the appropriate volume of Laemmli 6× (see 

Recipes). 

6. Dose the amounts of extracted proteins using the DC Protein Assay kit according to manufacturer’s 

instructions.  

7. Add the appropriate volume of Laemmli 1× to normalize protein concentrations in all samples and 

denaturate by heating at 95 °C for 5 min. 

 

C. Western blotting 

 

1. Load 20 μg of proteins for all studied conditions on a 10% SDS-PAGE gel. We recommend adding 5 μL 

of protein ladder to estimate the molecular weight of visualized proteins. 

2. When separated, transfer proteins onto nitrocellulose membranes as a standard western blot protocol. Stain 

with Ponceau red solution to check equal protein amount loading before electrophoresis. 

3. Block the membrane with TBS-T 5% dry milk for 1 h at room temperature with gentle shaking.  

4. Wash with TBS-T for 5 min on a shaker and repeat the operation two times.  

5. Incubate overnight at 4 °C on a gentle shaker with puromycin antibody diluted at 1/10,000 into TBS-T 5% 

BSA. 

6. Wash with TBS-T for 5 min on a shaker and repeat the operation two times.  

7. Incubate at room temperature for 1 h with the HRP-conjugated anti-mouse secondary antibody (1/10,000 

dilution) into TBS-T 5% dry milk. 

8. Wash with TBS-T for 5 min on a shaker and repeat the operation two times.  

9. Gently dry the membrane using paper towels and place it face up and flat on a sheet of plastic wrap. 

10. Directly add the Immobilion Forte western substrate onto the whole membrane.  

11. Detect chemiluminescence with the ChemiDoc imaging system (Figure 2). Intensity of the smear depends 

on cell ability to incorporate puromycin and is thus representative of protein synthesis rate.  

12. Rinse the membrane in TBS-T and transfer in 5 mL of stripping buffer.  

13. Protect from the light and put on thorough agitation for 15 min. Check that all bound antibodies have been 

detached by verifying that no chemiluminescent signal is detected on the ChemiDoc imaging system.  

14. Block the membrane with TBS-T 5% dry milk for 30 min at room temperature on gentle shaking. 

15. Incubate at room temperature for 1 h with the anti-tubulin antibody diluted into TBS-T 5% dry milk. 

16. Wash with TBS-T for 5 min on a shaker and repeat the operation two times.  

17. Incubate at room temperature for 1 h with the HRP-conjugated anti-mouse secondary antibody (1/10,000 

dilution) into TBS-T 5% dry milk. 

18. Wash with TBS-T for 5 minutes on a shaker and repeat the operation two times.  

19. Gently dry the membrane using paper towels and place it face up and flat on a sheet of plastic wrap. 

20. Directly add 1 mL of the Immobilion Forte western substrate in order to cover the whole membrane.  

21. Detect chemiluminescence with the ChemiDoc imaging system (Figure 2). Intensity of the bands is 

proportional to protein loading before electrophoresis.  

22. Quantification of the puromycin and tubulin signals can be performed using the Fiji software (refer to Data 

analysis section). 
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Figure 2. SUnSET assay demonstrating a repression of protein synthesis upon treatment with GCN2 

kinase inhibitor. HCT116 cells were treated or not for 24 h with a GCN2 kinase inhibitor (GCN2i also 

named TAP20) and exposed to puromycin (5 μg/mL) 15 min before protein extraction. Protein translation 

rates were assessed by western blot analysis using an anti-puromycin antibody (Puro). Tubulin is presented 

here as a loading control. The corresponding molecular weights are indicated on the right of the western 

blots. Results extracted from Piecyk et al. (2023). Quantification of the data on the left represents the mean 

± SEM (n = 3). Unpaired two-tailed t-test with p-value (** p < 0.01). 

 

 

Data analysis 
 

1. Open the Fiji software. 

2. Click on the File menu to seek for the ChemiDoc images of the SUnSET experiment.  

3. Use the Rectangular tool to graph a frame around the first smear to quantify and define the region of interest. 

4. In the Analyze menu, select Gels and Select First Lane. 

5. Move the section to the next lane and select Gels and Select Next Lane in the Analyze menu.  

6. Repeat the operation for each lane.  

7. Select Plot Lanes in the Analyze/Gels menu to create each lane profile plot. 

8. Define a closed area for each lane plot using the Straight Line Selection Tool to draw a baseline for each peak. 

9. Measure each peak area clicking inside with the Wand tool. 

10. Report area measurements in a Results sheet. 

11. Repeat this process for tubulin signal quantification. 

12. Normalize: for each lane, calculate the ratio SUnSET area/Tubulin area.  

13. Compare the ratio observed in each lane to assess the impact of studied conditions on protein synthesis rate. 

 

 

Validation of protocol 
 

This protocol was adapted from the original article: Schmidt et al. (2009). The SUnSET method was performed and 

validated for in vitro applications in several articles from Dr. Chaveroux’s group (Sarcinelli et al., 2020; Piecyk et 

al., 2021 and 2023) and other teams in the literature (e.g., Martineau et al., 2014; Mesclon et al., 2017; Arioka et al., 

2020; Fong et al., 2021). The SUnSET principle has been adapted for in vivo and ex vivo applications (Goodman 

et al., 2011; Morral et al., 2020) and at the single-cell level coupled to flow cytometry for energy metabolism 

assessment by Dr. Pierre’s group (Argüello et al., 2020). 
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